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Main Meeting Report

(If any Double Click member is interested in helping out with the 
newsletter, please contact one of the Double Click officers.)

Our March meeting included a Beginners presentation, an extended Q&A 
session, the main presentation and ended with our monthly prize raffle.



Beginners Session - March

Computer monitors have improved a lot over the years. We used to use CRT 
displays, and now almost all monitors are LCD based. With that evolution 
has come an increase in resolution as well. CRT displays could display a va-
riety of resolutions because the display tube could be controlled to paint the 
screen at a variety of dots (pixels) per inch. The earliest Mac displays were 
based on 72 dots (or pixels) per inch.

Now LCD monitors with around 100 pixels per inch or more are common. 
However, due to their design, LCD monitors have a fixed resolution. For 
example, my 24-inch iMac has a resolution of 92 pixels per inch. It gives 
me excellent viewing at a setting of 1920 x 1200. Other settings don’t ex-
actly match up with the physical placement of the pixels on the display, re-
sulting in some blurring, although anti-aliasing techniques (changing the 
color and darkness of the pixels used to form a character) helps.

The result of all of this increase in pixel resolution is that the display of 
characters is smaller. That is, if a character is 10 pixels wide, its physical 
display at 92 pixels per inch will be narrower than at 72 pixels per inch. As 
text gets inherently smaller, it also becomes a bit harder to read.

Mac OS X (and to a lesser extent, previous versions of the Mac OS) has a 
variety of ways to deal with this situation.



The Finder
 
Open a window, then open the View menu, and select View Options. A set-
tings window is displayed (with the same name as the window that you 
previously opened) in which you can change the size of the text that is dis-
played in windows. You can also choose between two sizes of icons.

 

Now click on the Desktop and do the same thing. This 
time the settings window that opens is named Desk-
top, and you will have view options that are specific 
to the Desktop you can also control the text size. You 
also have much more control over the size of icons.



Applications

Many applications have a function built in to change the size of text. Some 
examples follow:

Mail. Open the 
Preferences for 
Mail, and select the 
Fonts & Colors tab 
to adjust the default 
font type and size 
for mailboxes, mes-
sage lists, message 
text, etc.

When viewing messages, you’ll likely 
find that messages you receive will 
come in a variety of text sizes. To ad-
just for this, go to the Format menu, 
select the Style menu item, and then 
choose Bigger (Command +) or 
Smaller (Command -) to change the 
size of the text in email messages.



Safari. Open the Pref-
erences for Safari, and 
select the Appearance 
tab. Here you can ad-
just the default font 
type and size for the 
window.

When viewing web pages, you’ll find their text in a 
variety of sizes. To adjust for this, go to the View 
menu, and select Make Text Bigger (Command +) 
or Make Text Smaller (Command -).

Note: When referring to using the plus sign (+) 
and minus (-) sign in conjunction with the Com-
mand key, we usually are referring to these char-
acters found on the top row of keys (between “0” 
and “delete.”) The plus sign is the upper symbol on 
the key, and normally one has to also press the 
Shift key to type this symbol. In Leopard, at least, 
it doesn’t appear to make a difference whether the Shift key is pressed or 
not. The plus sign is still chosen when typed in conjunction with the Com-
mand key. This likely varies depending on the application you are using, al-
though I suspect that those from Apple follow this convention. Since it is 
the lower symbol on the key, the minus sign is typed directly without using 
the shift key. You can often also use the plus and minus keys on the keypad 
as well.



TextEdit. Open the Prefer-
ences for TextEdit, and select 
the New Document tab. Here 
you can adjust the default font 
type and size.

To adjust the font size in a docu-
ment, first select the text to be 
changed. Then go to the Font 
menu and select the Format menu 
item. From the pop-up menu you 
can select Bigger (Command +) or 
Smaller (Command -).

 



Zooming

Mac OS X has had the ability to zoom in on and magnify the contents of a 
window for some time. Open the System Preferences applications, choose 
the Universal Access preference pane, and then select the Seeing tab. In 
the Zoom section, you can turn the Zoom function on and off.



Also shown are the keyboard shortcuts that are set in the Keyboard & 
Mouse system preference pane. Open the Keyboard & Mouse system pref-
erence pane and select the Keyboard Shortcuts tab. Under the Universal 
Access section, you can choose the keyboard shortcut that will turn zoom-
ing on and off. (Option-Command-8 is the default.) Double click on the 
shortcut to choose it, and press another key combination to change it. In 
the Zoom section, you can similarly change the keyboard shortcut for Zoom 
out and Zoom in.



Back in the Zoom section under the Seeing tab of the Universal Access 
preference pane, you can adjust the way that the Zoom function works. 
Click the Options button to bring up the Zoom options pane. Here you can 
set the maximum and minimum amount of zooming that takes place when 
using the Zoom In and Zoom Out keyboard shortcuts. If you leave both the 
minimum and maximum settings at the setting of 1, then zooming will take 
place in increments each time that you press the zooming shortcut keys.

Zooming With the Mouse Scroll Wheel

Of particular interest and use to me is a feature that was introduced with 
Leopard, although it may have been in Tiger as well. I’ve found this really 
handy for zooming in on a section of a web page that is a bit too small to 
see clearly. Note that you must be using a mouse that’s equipped with a 
scroll wheel.

In the above picture at the bottom of the pane there is a check box that’s 
labeled, “Use scroll wheel with modifier keys to zoom.” When the box next 
to this choice is highlighted, you can choose the modifier key to use with 



the zoom function. The Control key (^) is the default. Simply place the cur-
sor near the area to zoom, hold down the Control key, and roll the scroll 
wheel on the mouse forward to zoom in and enlarge the entire window. 
Hold down the Control key and roll the scroll wheel backward to zoom out.

Dock Magnification

Finally, some of us don’t use the Dock magnification feature that can be set 
in the Dock preferences or selected from the Apple menu. If you keep mag-
nification normally turned off, you can still use it on demand by holding 
down the Control and Shift keys while moving the mouse cursor over the 
Dock icons.

April 20 Beginners SIG Meeting

At the April Beginners SIG meeting, we’ll explore another Mac topic.

--Steve Parker



”Q & A” Sessions / Announcements

The March Questions and Answers session (as usual) covered a wide range 
of topics.

Note: We would like to expand the meeting report coverage of his discus-
sion and need someone to help take notes of the questions and answers 
during this session at our monthly meeting. If any member can do this for 
us on a regular or semi-regular basis, please volunteer!

File of the Month

Jim showed a brief demo of a utility that he has found useful for displaying 
information about his Mac.

iStat Pro is a widget that runs in the Dashboard of OS X 10.4 and 10.5. It  
is a system monitoring widget, consisting of nine sections which can be 
shown or hidden. iStat Pro features detailed information on CPUs (up to 8 
cores), memory, hard drives, IP and external IP, bandwidth, battery, wire-
less keyboard and mouse battery, uptime, temperatures, and fans. You’ll 
know exactly what’s going on inside your Mac!

iStat Pro is freeware. You can get more info about it out here:

http://islayer.com/index.php?op=item&id=7

http://islayer.com/index.php?op=item&id=7
http://islayer.com/index.php?op=item&id=7


Member Presentation

Double Click members have an opportunity to address their fellow members 
at a main meeting.

The “3 Minute Ticker” is an opportunity for you to tell the rest of 
us at the meeting about a great computer program or feature you came 
upon... or something that turned out to be a waste of money! You could tell 
us about your best (or your worst) computer purchase, hardware or 
software, or perhaps about a good or bad experience relative to computer 
service. Share it with the rest of us! As the title of this feature implies, 
members will have three minutes to tell their story. A limited number of 
speakers (one or two) will be featured each month. 
 
“Tell Us About Your Business” provides Double Click members an 
opportunity to introduce the group to their business in a five to 10 minute 
talk. Suggested points that you may wish to address would be: 
 
• are you the owner, or a key employee? 
• when did your business start? 
• what product or service does your company provide? 
• tell us about the Mac computers you use. 
• how can Double Click members help you?
• what do you consider a good referral? 
 
Your membership in Double Click provides you access to computer 
expertise... now it may also improve your customer base. There may be 
customers for you right in the room! 
 
Members interested in presenting a “3 Minute Ticker” or “Tell Us About Your 
Business” talk should email the member talk coordinator, Jerry Smaglik, at 
<jsmaglik@wildblue.net>.

mailto:jsmaglik@wildblue.net
mailto:jsmaglik@wildblue.net


Main Presentation

“Other World Computing: A Mac Products Retailer”

Presented by Jen Soule, an OWC representative.

Other World Computing (OWC) has been 
providing quality hardware products and 
support to the computer industry since 
1988. The Illinois-based company is 
headquartered just 15 miles south of the 
state border in Woodstock, Illinois. OWC 
operates the popular www.macsales.com e-commerce portal which features 
one of the largest online catalogs of computer and iPod enhancement prod-
ucts, specializing in Macintosh upgrade and expansion products.

Jen presented a history of the company and explained their business phi-
losophy. She noted that OWC has grown tremendously since its inception, 
moving successively into larger quarters, culminating in a new eco-friendly 
building that is just now being completed. The new site will include a retail 
store so we will have the option of being able to see the OWC Mac-goodies 
with our own eyes after a relatively quick 80 minute trip from Milwaukee.

During a Q&A session after her talk, we heard from several Double Click 
members who shared positive testimonials of their experiences with the 
products and services of OWC.

http://www.macsales.com
http://www.macsales.com


April 20th Meeting Preview:

“Photoshop:
Layer Basics from the Bottom Up”

Presented by Lynn Rieger,
a Milwaukee-area Photoshop tutor.

The ability of Adobe’s Photoshop to work in “layers” is one of its most com-
pelling features. Lynn’s presentation will cover all the different kinds of lay-
ers, their uses and characteristics and how to make them work in a “layer-
based workflow.

Lynn has been teaching “Getting Started in Photoshop and Photoshop Ele-
ments” in the University of Wisconsin - Waukesha Continuing Education De-
partment for 4 years. She is the president of Photo Pictorialists Camera 
Club and also a member of Wehr Nature Center Camera Club. She will dem-
onstrate layer techniques using her own images and will provide two refer-
ence handout sheets for the audience to use during the presentation and to 
take home.

Check the Double Click website for more meeting information:

www.double-click.org

http://www.double-click.org/
http://www.double-click.org/
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